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https://developer.arm.com/downloads/-/arm-instruction-emulator/eula

arm

Serial Number:

Certificate of Authenticity

This certificate entitles the user to a software license for 15 sea

Development Studio UBL Gold FUSA (IIEGNG

f
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(AMH)Cloud License Server 7 Al 710|E

 Arm UBL 2}0| 2 #e|H0][X|= o] F 3 =l
* https://developerarm.com/support/licensing/user-based/products
- XAl 2o A e[ 1D 23¢9 EHR
L EHEIT} E|ASIERHE QI olA 7t 7HS B ID Flok -

Add a product

* Products B0f|A| Add a productE & gtL|LC}.

- M o] X|of| M 2 AE2|Y HHE U F Redeem HES S2IEhLICL

15/ 15 seats used
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(MH)Cloud License Server 2t

- = Generate activation codeS Z&!gtL|LC}.
O

=]
 Generate code= TO{St 2tO| M A Seat +=RHE 7t=

- TableO| MM El Activation codeZ} EA|EIL|C},
- Activation code= 7€ &¢ AHE 7tS5HH SSE PCo| MRAUO0| 74N U™ ALE 7|2t 7Y XtEs A
- AFE 7[7H0| B2 | MO SZEl Activation codeZt AF2tE
- Activation code= 8AE|-4At2|-4A}E[-4K[2[-12AtE| 2 4

User = Seat held until Created on Status

TaeJun.Park Feb 05, 2024 Jan 22,2024 Inactive

MDS518 Dec04, 2023 Activated

MDS516 Dec04, 2023 Activated

MDS15 Dec04, 2023 Activated
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(22}0|AH E)Cloud License Server 7 Al 70| E

- Keil MDK2| A%

* File > License Management > User-Based License > Activate/Deactivate =

- Arm Development Studio?| Z £

- Window > Preferences > Arm DS > Product Licenses > Manage Arm User-Based Licenses = =

- ™ | o] X| o] A
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I Activation CodeS ¢

aal

Q& T ActivateES £2!6}0]

oA S5

=, Arm License Management Utility

Activate your product

Recently Deactivated

Activate with: O Activation Code

— *

O License Server

Enter your product activation code:

W—W—W—M—W

Activate

Help

Close
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(22}0|AH E)Cloud License Server 7 Al 70| E

Zut| Standalone A9 AL Zulda| HX| £ > bin EG 2 0|5 ¢grL|Cl.

armar.exa 2022-03-04 2 124 EE ZETE 4 055KR

AlSHTTLOI 2 SLOolS NI OF 173 oo D= 1 NISKR

 armlm E?gll- == %!' ._I %H— Ct. (] armasm.exe 2022-03-04 2T 123 S8 2232 4,035K8B
10 armclang.exe 2022-03-04 2 124 ZSSEZE 80,043KB

« Window?| 4% armlm.exe B armlink exe 2022-03-04 27 123 S8 EE=1w 10,512K8
ANII_NR.0T QF 907 S22 D= EE 4A0KE

. |_|nu)(9_| zg_cl)_ arm|m O|D|X| Darmlm.dll 2022-02 ._:n—|_._.u._ ; - _=_;= = - K.
W] armlm.exe 2022-02-23 2F 100 22 == 5,772KE

armim-ipc.exe 2022-02-23 27 1:.00 S8 == 5 783KB

[4] concrt140.dll 2020-09-29 2% 1:52 2S£ =2 =% 325KB

°
OF

1S d20M E{0|'2S OpenglLILt.
- AUt X|E 24 2ol bin 2HOIAM HOIE 27|

.Jarmlm activate --code <&/d3} [ E> HHOZ 2l0|MA SE S OF 2| gL Cl.

C:\Program Files (x86)\ArmCompilerforEmbeddedé6.21\bin> ./armlm activate

- .Jarm deactivate --code <&Md3} [ E> HHO=Z ZI0|MA H|Z/EH3} 7t
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(MH)Linux License Server 7 AM¢d 710|E

L LLSE 57 2|52 HH|A HX| JHsELICH
* Red Hat Enterprise Linux / CentOS 7 & 8 / Ubuntu 20.04 LTS

O

- 2|52 PCOlM E 2to|EE{2| S EX gLl
* sudo apt update
- sudo apt install -y openjdk-11-jre-headless python-is-python3

- MH S/WE CIREE 2 2|52 pcojl AX[RL|CL
» https://Im.arm.com/downloads Z 30 Af flexnetls-armimd-<version>.targz It CHRZE Z 2|52 AH PCE T

- tar —xvf flexnetls-armimd-<version>.tar.gz @ E 2 Z 2= x|

- sudo ./flexnetls-armimd- <version>/install _license server HEH O 2 Z|SA AMH AX]|
- Moz MX|E|QO™ CHEe| 2EO7F EAIE|D MY S/WE Atsl = ASHL| Y,

License server service fTlexnetls-armlmd is starting, and will start automatically on system start-up.

Waiting for license server... (up to 120 seconds, or press CTRL-C to stop waiting)

License server running and ready to accept requests at http://<external server name or IP address>

hd MDSTECH 13



https://lm.arm.com/downloads

(M H)Linux License Server £ MY 7o =

« A 2fo|MA S/WO| Default BX| A2 = /opt/flexnetls-armimd & L|C}.

- 2% CIMEC| 9 bin ECE &3 H2 X|™oto g7 8= == = ASLILL

- export PATH=/opt/flexnetls-armimd/bin:$PATH
QAN oZ 3l HAZE XAt O OIS W Alsy

o T =

- sudo vi ~/.bashrc &, ™ Ot2fZ 0| export ARMLM="opt/flexnetls-armimd/bin”, export PATH=$PATH:$ARMLM 2Z 7|
- & = source ~/.bashrc H 3

- Otz BFS WS Arm 20| M A M H|RHZ S HF L L.

. 7 S armlm_change_admin_password
¢ armlm—Change—admln—password Default admlnlﬁtratlvc dLLOUNL pdSSWOI U UELECLEU.
- Please enter and confirm the NEW password for the administrative account.
(m ] — = A E A O
- B2 = HHAEAL, <AL S+

L L The new password must meet the following criteria:
Hl U= 2Z O'”EI" leH Hl IHS - Between 8 and 64 characters
O

- At least one digit

E|—O|A‘|A -||:|-| = [:l-Al M XloH |: 'c')'l- - At least one uppercase character
- At least one special character (for example, "~*$-+7 &=1%{}/#@)
° )\o-l_g_&ll og I:II_:|7C:>IE| A g :I |___|-2 - No whitespace characters

MEW password:
Confirm NEW password:

Administrative account password changed successfully

hd MDSTECH 14




(MH)Linux License Server 74 MY 70| =

- Ol HYES Y =, AI8E T2 E DO MACFAE 7|AFLICH.

"selected" : {
« armlm_show_hosted

"hostidType™ : "ETHERNET",
"hostidValue™ : "081122334455"
= A — I
: A-I H-I ;Ag Ic"l EE Txc-’l %I- LI I:I-' Make sure ye with the docume

H H=#

before making changes to _'ii file.

- sudo vi /opt/flexnetls-armimd/server/local-configuration.yaml E &
« AHEE port H= =74, default ZERH 2= 7070
o (MEH) active-hostid =AM #) oA = [0A 7o MAC =2 F

Ol Al) active-hostid: 445566778899/EHTERNET
- HE At 20l = HE

HTTP listening port. Default is 707€
'-'.2|'|1'_:|'-:..-- ln_n' | | l] _'"_.'"-'|1

5
H+
X5
IT

=)
o
=
(o

HOHEH R B R

acture hostid: CS85B76EF1DZE/ETHERNET

- 2fO| A MHE XY AESI0] HEAS S AP L.

* sudo systemctl restart flexnet-armimd

hd MDSTECH 15




(M H)Linux License Server £ MY 7o =

- o M BEE =Q1517| 2ol ct52 8FS Y™ CL

« armlm_check_server status

.

$ armlm_check server status

License server running and ready to accept requests at http://<external server n
ame or IP address=:8226

- 2o MHVE 2l SO| Otz 87, Ofel B82= MH =X

- sudo systemctl start flexnetls-armimd

- Ol EL2E identity LS H-deL|Ct.

‘ arm|m_generate_server_ldentlty --identity-file identity.bin
- Ob77} ZHAHst arm 2HO|MA MH H|ZHS QI

S armlm _generate server_ identity --identity-file identity.bi
Generatlng the 11:en:e server ildentity file.

Password for 'admin'
Activation response written to fhome/park/Desktop/identity.bin

- identity.bin IF M =20l

hd MDSTECH
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(MH)Linux License Server 7 M 710|E

- identity.bin ItY S SEEL|C}
- O] I 2 AMH|, SEf0|HE & O|= PCOM S &2 BlS
=} =2

- https://developer.arm.com/support/licensing/user-based/servers H|O|X| O| & = Register a server = &

=2

» Choose or drag & drop your identity file here 5

- identity.bin I}Y S5 F Upload file & register server = &

=
. Server name2 32O Z E AR, ARM-(HE=XHE Xtz 4™

Register server

Server name

Server name

hd MDSTECH



https://developer.arm.com/support/licensing/user-based/servers

(M H)Linux License Server £ MY 7o =

- Ot 20 M 20| A ME{7} BEdHo 2 SEEIU=X] =

* https://developerarm.com/support/licensing/user-based/servers

Products Servers Orders

Local Servers

_|_

Register a server

olghL|ct,

Development Studio UBL Gold FUSA

- SEE AH HEZ 2&I51¢ 2| H0|X|2 0| F¢etL|C}.
« 7 2|0 MB| 2tO|M A A O] MACT A HA
- PRODUCTSOf| 70§ 2t0| M A B2 HA|
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https://developer.arm.com/support/licensing/user-based/servers

(M H)Linux License Server £ MY 7o =

« MHOf|A| ALEE 20| M A Seat =& K| ELILC.

« Default= 0
- HZ A0 RULCHH Confirm Changes HHE 243}

. ' ES g HAH AISHS HAFSHL|C} —
Confirm Changes HES =& HE Al S X &gt T
- HE A0 ' 2

SACHH Confirm Changes HE H| 2

Download licenses

Upload confirmation

° E_I-OIL"A bln _u_I.OI o EI"?'EE -ohl_LI EI_ Obsolete server

0 (incl. O overdraft)
- Manage Server > Download licenses = =

- LR Z2E B2 20| M A binItY AMH PCE EA}

- 2tO|d A bin ThR2 22| 7hset Tt MEots A0 E5

- 2fO|/ M A bin OtY ZU2 CtZ1t 5L Ll
. licenses-<AM B MAC A >-<2}0|MA Al QLS pin
O1|*| licenses-C85B76EF1D2E-2024-01-30_02-59-36.bin

hd MDSTECH




(M H)Linux License Server £ MY 7o =

- Ol FE2 2 2fo|MAE SEELCL

el — = R I — |

- armlm_update_licenses --data-file <2}0|MA binI}t >

: S armlm_update licenses --data-file licenses-C85B76EF1D2E-202
4-01-30 _02-59-36.bin

Password for 'admin:'

Licenses have been successfully updated. No confirmation is required.

L 2HO|MA AfH B2 S

LS 271 55|H B4H2 2 S5E AYULLL

Licenses have been successfully updated. No confirmation is required.

hd MDSTECH
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(22}0| YA E)Linux License Server 7 Al 70| =

. Keil MDK?| A%

* File > License Management > User-Based License > Activate/Deactivate =5

- Arm Development Studio?| Z £

- Window > Preferences > Arm DS > Product Licenses > Manage Arm User-Based Licenses 2

=2

- Activate your product > License Server B = Server TAE Y=L}

—_

* http://<Ol0|I| FA><EE Ho> U3 S Query HHE &

- N E 20l

=/ L=

hd MDSTECH

Z Activate 25 F 2f0|d A 2d

A, Arm License Management Utility

Activate your product

Activate with: O Activation Code

Enter your license server address:

http://192.168.35.147:8226

O License Server

Query

Select the product to activate:

Arm Development Studio Gold FuSa

Help

v Activate

Close

=
=

21




(22}0| YA E)Linux License Server 7 Al 70| =

- Ant 2| Standalone W4{2| 4L Autge| HX| EH > bin EC 2 0| S L|C}.
armar.exe 2022-03-04 27124 SEIDETH 4,055KB
e armim AEI %EI'OEI % é!'?_l -°|;|' LI EI-. armasm.exe 2022-03-04 27 1:23 22 EEO¥ 4,035KB
) o armclang.exe 2022-03-04 2 124 ZSSEZE 80,043KB
« Window?2| 8% armim.exe F] armlink.exe 2022-03-04 97 123 28 Zz=I 10,512KB
ol 740 ololx [%] armim.dll 2022-02-23 2% 202 S8 ZEIE =% 40KB
‘ LInux_' o armlm | | | ] armim.exe 2022-02-23 278 1:00 58 =1 5,772KB
armim-ipc.exe 2022-02-23 2T 100 SEZ=ZEIE 5,783KB
[2] concrt140.dll 2020-09-29 27 152 22 ZE2I¥ 2% 325KB

-5H'=* 704 Of| A 51 Ié% Op ngtLICt.
E 22| bin S2HOIM HOIE 7]

- ./armlm activate --server http://<IPFTA>:<ZE S > --product <Product Code> Y2 E 2}0|HA
sSS= =gy,

o=

PS C:\Program Files (x86)\ArmCompilerforEmbedded6.21\bin> armlm activate http://192.168.35.147:8226

Activation of Arm Development Studio Gold FuSa was successful.
- /armlm deactivate --product (Product Code) B@HOZ 20| A H|ZH3| 7t

hd MDSTECH 22




cfo| M A 22| Xt 70| £

MDSTECH




Cloud License Server 2fO|MA

2| X} 710| £

- Arm User Based Lisence ZEH0| 2191 $tL|C}.

L SBE HIE EIYS 2T

=E=2 21 -
g-dztEl HE0[ S

110 Add a product?t 2 42 2 0Of

. EAE B0 20| M Users Z43}E PCo| 0|22 EAIELCL
- AHE 2det AEE 5% PCYt QICHH SECE HA|E L O
. 243} 3

- Copy activation code, &8st IEE

C
- Revoke activation code &3} A EE F

 Revoke activation codeE Z&I6l™H ojzfje] & =

ra
2E oo [RHES 233t 271x] 7158
P c

2
- EHdol I E SA| ALF|
- &M IAEE PCO| SESIX| Y2 FL2
- 2ot IEE PCO| SEUX|T ST PCOA Arm tool
- 31 AE HIEY3}
- 2ot AEE PCYHl =MD S| PCO|A Arm toolE 78 =0t
- O] A0 ST PCOIA Arm toolS AtESH T MHF7|7F AL

7 HHEH AEO 7t MH{XIH CFE A

fuiot
0x
lot
kU
| n
"' 0

=2

o

T
el,
i
10
b
K
i
ne
o>
L
i
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https://developer.arm.com/support/licensing/user-based

Linux License Server Z2|X} 7}0|E

- BIO|MA MHE HX|5}7] sl ofef HHS Uz T

o

* sudo systemctl stop flexnetls-armimd

- sudo systemctl start flexnetls-armimd (A& /
- 20| A MHE 2Qls5t7| flol of2ff HHES =L

« armIlmd_check_server_status
MHof| SEE 2to|MAE =tQlst7| Sl o2 HHS
 armlm_list_product --show-expired —utc
- 2| X} H|HH2 & HAESH| flolfAM of2f BES UE
« armlm_change_admin_password
- H 2 M = of2fe| 7[&== THES|OoF LT},
- 8~64Xt
of Rte| =&t

ot xt2| Ch2 A}
ol E42x}

A
HA

R4 g v S v 3

o _

OH

o
=

2 E BB b

o
rE

Dt 3dHeo s HERH OEe =

hd MDSTECH

2o MA M E A|ZH/RA|ZHSE7] Ql8l ofef HEH S QladstiL|

Administrative account password changed successfully

25




Linux License Server Z2|X} 7}0|E

- ST BHO|MA M7} M3 FOIX| HQIstHT of2f WS YSL|CL
« armlm_check_server_status

. Mu{7} M8 Z0| OfL|2tH C}2 HHY
* sudo systemctl start flexnetls-armimd

. B1O|MA AMH{7} A|ZHE|X| O™ systemctld M 28 2H9l0| 7H5BLIC)
« Journalctl -u flexnetls-armlmd.service.b

- 2tO[ M A2t AR M3 9} TR E O] MAE =Qls
 armlm_list_products —show-expired

. ST AR B|AEE K|A8E{H of WHS YyBL|CL

* armlm_list_users

o

AFE3H0] M E A|ZtBL|C}

ﬂII

!

o
L
i)
o
9
mn
——
mlo
144
1
oot
r
1
n

 Arm EIO| A ZRIM AFET 5 Q= 20| ML 71 Mo 2 E 88 A= s Bfo|HA +F Zaiets 42
- Arm 2}O[d A EEHO| I F EtLO| §2 AERCH 295t AEL SEE FM0| O Bths 207 BAlE UL
- O] If 22 Yot AE(CLS)L 2H0[H A MH(LLS)0 Bo|MAE 2EE 4 glonz XRntE 2to[dA +5 ZAAFH0f ghLCt
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Linux License Server Z2|X} 7}0|E

- ™ 2lo| A EHE[Xt7} E[A/RMO|ES S22 EH0|M A AHO| AN A S = gls FF oref 2 T gLt
- Arm User Based Lisence ZEH0|| 21 QIgtL|C}
- MZ 8= 2=5t1 Local Server #l& 2=0tH 20|44 AMH O|F0] Server name E0i| L& &/ L|LY.
- S StHZ AT = MDSH|Z 0| AHESHUA|L.
« Arm UBL 22| ZEO|M AMEXZ} X 2t0o[M A7 27" LI
- O|T MHE &3] W7|St= & Arm AR Q| Xt O] EagtLCt.
* LLSOIAM CLSE O|H5t= S2| AR 2 2l0| M A MH S AFH|/m| 7|5t 0 ACHH Ofgf= T
- Of2ff BHEe = 2to|dA MHE FX[gL T},
« sudo systemctl stop flexnetls-armimd
- ol HOlE B2 & of2fel 271X a2 & N elet 2= HET LT
- 2HO|MA MH HX| Default 4 2: /opt/flexnetls-armimd
- OI0|H M7% Default dZ: /var/opt/flexnetls-armimd
o 3o = 2fo|dA MHE M AL T j
- sudo <2tO[MA MH AX| ZE)/bin/armim_uninstall_license_server --delete-storage

- --delete-storage= M & AFSRLICL O Z21E & USIH L& 2to[dA, 22|X HEHS, M LES =g
LIk

- 2PO| A ME AH| &= H7|5H7] AP HE HEFELICL

ot

FL| Cf.

Ot

2= HO|EHE AA

r

hd MDSTECH 27
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- S20|AHEOM 2f0|MA M URLS Q1A = =X =0l & = st
- armlm inspect —server <Al URL> & &
« N URL2 http://<IP address>:<Port>2Z T
.« <Tools AX| Z20>/bin0f armIm It /X

- S2O|UETI MO HAZE =+ U= B8R 0| B2 MHOM A& Zhs¢et Crefet 2to[d A5 Higt

PS C:\Program Files\Arm\Development Studio 2024.0\bin> armlm inspect http://192.168.35.1U7:8226
1 product found on license server http://192.168.35.1U7:8226:

Arm Development Studio Gold FuSa
Product code: DEVST-GLDF
Order Id: 0000214172, valid until: 2020-11-02

hd MDSTECH
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(2] =2 )flexnetls-armimd- <version>/install_license server &M

- |52 PCOIA 2to] A MHE EX[2 U AL 75t M2 ChE3at €5 LI

sudo [-E] flexnetls-armimd-<version>/install_license_server [--port <port>] [--install-dir <installation directory>] [--data-dir <data_directory>] [--user
<user>] [--group <group>]

 -E
o 7= HHEE REZ MAMT [ SiX| AF2XLQ| 2t A S EETLICE O|= JVM(Java Virtual Machine)2| X7} SHX| A2 X} 2HA 0| A=l JAVA_ HOME 24 Bi=0f o|&
St= 42 222 = USL L

* <port>
o 2lo|MA ME 7L =41 Cf7[St= TCP HIEH A ZEE X|EE LI --port Di7 H =7} X|HE|X] 2 42 ZEE= 7|28 Q2 707022 A7 ELICt O] ZLE HY= FEE A

o= TENABOE O A0 Q2B E 1024 0|3t ZEHZ E X8 = S LICL

- <installation_directory>
« ZHO[MA MH AZEQ0{o| K| C|AEZ|JL|C} -- installation directory Of7H =7t X|HE[X| g2 dF X CIHEHE|= 7|28 22 /opt/flexnetls-armimd 2 47& & LICt.

+ <data_directory>

-« 2fO[dA M HEf ot W 25 MYot= O AAEEl= CIHE 2| LT --data-dir 070 #H 7 XIGE[X| =2 Z% HOIE CIAE2[2] 7[24t2 /var/opt/flexnetls/armimd
OI|_| |:|.
[=| .

e <user>
o ZFO|MA A7} HME|= AFEX} Ol RILICE —-user Oi7HH 7 X HE[X| A2 F2 2I0|MA M= flexnetls AFEXIE ASHEIL|CH
. <group>

o 2lo|MA MH It MEE|= O F O|F Y LICE --group 7R H =7t X[ H K| A2 B 20| A MH = flexnetls IE2 2 AHE L CF

- gfo[MA M= 2X| Z2MA7F 2BEQUS I XS AZEIH M PCIt CHA] A ZHE I XIS 22 A|ZFELICE.
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@IS 2)2H0|MA M M%| &

« SO A MH 7L BX|E|H XS 2 AEHEL|C

- SO A AMH MH|AE PCRt &H XS 22 A% 8 SX|E|=F /g EL T

- 2X| C|HME2|of= otele| mtof E"EE' L|C}.
- bin0l= 22| FEE[E|7} 2tk ASL
- etcOfl= H[O[Ef S MH C|2HE2[0f CiSt
- server®= 2fO[MA MH O =1} HEJ ah

A
=
« MX| Z0f| AX| A2 S HASIX| U2 AL AMX| C|dEE|9] 7

- /opt/flexnetls-armimd
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cto| A B3|

- 23 2 ALEX= 7Y€ S HF 2ol 2of SEEL|LCL.
AFBEZE UBLE XIIBHs Arm A E7-8 7Y 0|30 ALBSHE T3t IE URL i 20| MA MO 22|10 C+g 72 SO 2fojMA
o B LI

o
- 72 0|20 = AHEOIX| HE 87

« MHO|A oS 2to]d A 2det ZES Revokedt] A2 2 *FRXPOMI SAl 2ol & AELIL
« MHO|A Revoke SHA| BB 0|0] SEE RN MSE 2 R 80| AXMEX| CHA| AL 7S EHLICH

- HZ 2lo|ASE AEE & gl dR0U= 7€ X
- O|= EX[7} 2fo]d A& MHof| &

_Jlk_
- 2] FX[of|M Efo[ A EFste + ASL T

=
- AFEXHOA L FE ME 2to|dAE o2 HX|0AM AP &= ASLICH
- OS2 T StLE ALESH0] AFEAMOA 2 E 2tO|MAZ CHE T ALY = JUEE & 5= AL
o M XN SLS AL UE Arm JHE =10 CHEE MIE 20| MAE EdstetL T
« FHAIE Arm H|E 20| M A ME ME+E armim ClEE 20| HEHE L|CE
« Arm i =T E AE5tE CHE EX|&= Cfaat 242 SR 2 FHA|E 20| AE AR = ASLICHL

- armim CIEHE[E M X 22 CIHH2|0f SAtgLCt.

- armim CIAHZ|E HESYA CIHEHZ|0o| SAHELICH A ZX[0| A ARMLM_CACHED_LICENSES_LOCATION 2+ tH
M sHL|C}

=N eN=| .

+E HEYI E210|E2| armim YK =2
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Keil MDK Professional UBLE PK51 A}26}= HitH

« Keil MDK Professional UBL2 O|H Keil toolt AT = QSL|LCT

Procedure
« MDK 5.37 O|7 H{#, PK51, PK166, DK251
|_ o - 1. Download the Arm licensing utilities file from the Arm website:
- 0SOj| &= Arm License ManagementE CI2=EEgHL|C}|. >
- CIRECSH =% i S &= sliA| 2L C.

- binEG 2 0| F £, armim-gui.exeS A& 3tL|LCL.

« CLS/LLSO| S¢A| uBLS =H/d3} StL|CHE O+ % 1)

armlm-gui.exeE &L C}
bin Z2C0|A O 2 £ &S Sl B 0|2 (cmd/powershell) S L L}

ofz HES YUHSHH T Tool0ll %Al LIC7} E{D| 20 S EL|CL.

armlm genlic
AHAiEI LlCE KQIIO'" %%ﬂLl EI'. lCcense | 5 (LIC) :
AMZ70-VT1M1-F270K-C7TX3-3FT8N-5ETHB
Feil PK51: WH72V-SFI8T-28FUS-UUGSY-EABNS-K9D06

Feil PEléée: SDETC-RPZW/-EYI1H-S5cZWS—-BNSSE-D5AQJT
Feil DE251: SDIGER-EZGTR-WOYEI-cFVVA-XSEMT-/LG15
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https://developer.arm.com/documentation/102516/1-3/Activate-and-deactivate-your-product-license/Activate-a-license-without-installing-tools?lang=en

A2 XH7F UBL &

TIE +328 g¥ol= Y&

*GUI =& 98 85

o o
- Arm License Management UtilityOil Al ZHd3}El 20| M A S S 8l81 10 ReactivateS 22| THLICL.
% Arm License Management Utility 1.3.0 - X
+ Actvate your product Arm Development Studio Gold FuSa Deactivate

Product code: DEVST-GLDF I Reactivate I

: Order Id: 0000214172
J= St A ye ipmect Seidc Gold futa License server: http://192.168.35.147:8226
Expires: November 2, 2024

Expires on: November 2, 2024
Cache expires on: July 25, 2024

‘(j Help Close

carmm A& I bin 2L Z 0| =gL| Lt
- 2[Rt Hote 2 HOldE €10 ol HE = ESL| L}
3
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AHEX7L UBLE S22 H|2de|o}

*GUI =& 978

2

« Arm License Management UtilityO| A 2Hd3t=l 2t0[ MM AE S E|SIL DeactivateE 2

hd MDSTECH

+ Activate your product

@ Arm Development Studio Gold FuSa

Expires: Movember 2, 2024

2| St | |-
| 14 L E .
A Arm License Management Utility 1.3.0 = =

Arm Development Studio Gold FuSa I Deactivate

Product code: DEVST-GLDF AETEL
Order Id: 0000214172
License server: http://192.168.35.147:8226

Expires on: November 2, 2024
Cache expires on: July 25, 2024

Help Close

35




> 23 =
I = EHE

- 7|& Ojjd] uBLe| FHo| £t R?
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CHE/HAE S5 B4, X7 £9 58 S 24, R%Y 37} 50

- 22| JEEFE0M UBLO| R CopyZt ERTHX] OB A ALt5ILtR?

. QIR O 2 J|etxpo| £ OlL|C}
- 7|E FlexNet &t82 =2 ALE SO[2tH Imtools 215 &
. UBL% 7| & Floating 2}0| M AL} S 2HdO| QILIR?
- D2E|X| ol M= CHEAH 2835H{0F gLCt.
Y 52l IR 2N HOIM MET + Lt
- CLSO| &% CIEulo] HAL[O] UCHEH AMEX| AHE 7hs= L T
« LLSO| 8% AMH{2F A0 7|'6-6|'7'|L|' SHF7|7t F2OICHH ALE
. M8 2| 1 80| SILSILER?
- CLSO| 4% MH A&, Z2H[Md, R &2lg 2art &Lt

* LLS= 7[& Floating/FlexNetO H[3{ G|O|E In/OutO| X3 =0|&

L 2EIQE i JHABHM AR £ YULR?

- 2ERE SAE VLS HLS FQ Use caseO|H UBLY| LHEE 7|5
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